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Learning Objectives

e Learn comprehensive steps for controlling project system settings, including
mechanical and electrical system project settings

e Understand how to create the target and source relationship between equipment
without routing a duct, pipe, or wire

e Learn how to capitalize on the system sizing and analysis tools, and learn how to
maximize project performance when you don't need these features

e Learn how to improve the quality of your construction documents by capitalizing on
system-based features

Description

Revit software systems help us to define the MEP (mechanical, electrical, and plumbing) design
in several ways, but the main purpose is to understand the relationships between system
equipment, such as air terminals to air handling units, or from light fixture to panel. This hands-
on lab will teach you the comprehensive steps needed for controlling project system settings,
and then it will demonstrate how to capitalize on (or disable) sizing and analysis tools related to
the system. We'll cover creating the target-source relationship between parts, and then we’ll
review using the systems to improve the quality of your documentation. On top of this, you'll get
a project template that already defines everything in the class, so you can take advantage of
these topics right away. The class will cover HVAC (heating, ventilating, and air conditioning),
piping, and electrical items, so come and join us for this fast-paced but thorough lab—you’ll be
glad you did! This session features Revit MEP and Revit.

Your AU Expert

David Butts is an Autodesk Expert Elite Team member and Building Information Modeling (BIM)
specialist for Gannett Fleming with over 30 years of experience in the architecture, engineering,
and construction field. He is responsible for implementation, training, BIM project support, and
management for engineering design applications, including Revit software, AutoCAD P&ID
software, AutoCAD MEP software, Navisworks software, and more. He was an Autodesk
Authorized Training Center (ATC) training manager and application engineer for an Autodesk
Reseller for 13 years, providing implementation and training services across the United States,
and serving as a subject matter expert for Autodesk, Inc.’s, Building Design Solutions. He has
design experience for a variety of project types, and he was the Autodesk University 2011 top-
rated speaker for labs and lectures. He authors training videos for 4D Technologies, and he
presents BIM topics for other industry associations annually.
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Perfecting the System for Revit

When you are designing a project, there’s a big difference in how you approach your work in
CAD project versus a BIM project. In BIM there are tasks you have to complete that never came
up in a 2D project, but then there was a high likelihood of signals getting crossed, and systems
being incorrectly defined. Revit's system and circuit tools, which have been around since the
beginning of the MEP tools, continue to be refined and improved. That is the focus of this
session, and hopefully you will take away some information to help you leverage the benefits for
these tools.

The System Rules and the Four Step Process

The methods used by engineers and designers to create HVAC, plumbing, piping and electrical
systems has not changed since the days of hand drawing, other than the improvements to
equipment. The work process follows a straightforward approach, where the building
requirements are assessed first. The necessary equipment types are selected and located, and
then the connecting components, such as duct, pipe and wiring are added.

Once these are added, critical data and directions are provided in the construction documents in
the form of specifications, schedules, and annotations on drawings that identify and label the
components. While there are occasional points where you step outside of the process (such as
locating critical duct/pipe items in a chase), the process stays the same.

Using Revit for MEP design works best when you implement a four-step process that emulates
this approach. By following the same repeatable process, you can get more efficient at
completing our projects on time and under budget. The primary steps are:

o Select and Locate Equipment — the targets and sources that define a system;
Define and Refine the System — creating the system that connects the equipment
together;

¢ Connecting Geometry — adding the ducts, pipe, conduit, cable tray and wire;

¢ Annotating the Model — adding tags, schedules and other annotations in views for the
construction documents.

The logic in this approach is to create a consistent method of approaching work. The second
step, defining the system, is a task they typically is not accounted for in most projects budgets,
since it was not required for plain AutoCAD or AutoCAD MEP.

The system is what links the sources, which are the end-of-line equipment that provide air, fluid
and power to the targets. The targets include items such as air terminals, motors, sinks, and
more, and are what is used to define the system. These items are usually placed at the same
time as the primary equipment, after the overall assessment of the building needs are
determined.

When you are defining systems, there are few key items you need to review prior to adding
anything to a model.
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1. Always start from a template. The template can be discipline specific, but Revit works
best when all disciplines are defined within a single model. While this obviously can’t
occur when the disciplines are divided up between firms, internal projects should follow
this workflow. Systems cannot be directly connected across linked files, and require
a connector element to be added when the disciplines are separated.

2. Your template should include key families that require predefined type marks, such as
light fixtures, air terminals and receptacles. Traditional construction documents label
these items by type mark, which is a default parameter in Revit. Since the type mark
can only be defined after the family is loaded into the project, get these loaded first.

3. The template should also include predefined system types. Based on predefined
classifications, such as HVAC supply air and plumbing domestic cold water, the system
types allow you to create more specialized systems.

4. The Target always defines the system, and in order for sizing to be used, you need to
have a Source — but a source is not required to define a system.

NOTE: IMAGES IN THIS DOCUMENT MAY INCLUDE RIBBON TABS THAT ARE NOT PART OF THE SHIPPING VERSION OF
REVIT. PLEASE REFER TO THE TEXT INSTRUCTIONS FOR REFERENCES TO THE DEFAULT INTERFACE LOCATIONS.

Defining Project System Settings

When you start from a template, you can include predefined settings that apply to the most
common project types. Behind the scenes, there are common project tools that impact how
duct, pipe, circuiting and more are defined in the project model, so it is a logical place to start
when working with systems.

From the Manage tab, settings panel, click MEP Settings:

MEP Settings ~

lI Mechanical Settings
il 9

\;i\ Electrical Settings
& Fabrication Settings

Load Classifications

o4 Dernand Factors

;J Building/Space Type Settings

MEP Settings include tools that control project specific settings. These can be defined in your
project template, and edited in a project after it's started. We’re focusing on mechanical and
electrical systems, so let’s start by examining these values.

Mechanical settings control duct and pipe settings, including:
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Mechanical Settings

[=)- Duct Settings
Angles
Conversion
Rectangular
Crval
Round
Calculation

= Pipe Settings
Angles
Conversion
Segments and Sizes
Fluids
Slopes
Calculation

dimensions

? et
Setting Value
Draw MEP Hidden Lines
Line Style MEP Hidden
Inside Gap 1/64"
Outside Gap 1/64"
Single Line 1/64"

Hidden Line settings for crossed duct and pipe objects;

Duct and Pipe settings for annotations, and for project wide sizing tools;

Angle settings that are applied to duct and pipe fittings

Duct and pipe default materials and elevations, based on system classifications
Predefined sizes based on duct shapes, and pipe materials, including inside/outside

Calculation methods used for duct and pipe sizing

o Pipe specific settings for fluid data and predefined slope values.

Electrical settings cover a wide range of project specific settings, including:

Hidden Line
General
Angles
=) Wiring
(=) Wire Sizes
Comection Factor
Ground Conductors
Wiring Types
Voltage Definitions
Distribution Systems
=) Cable Tray Settings
=) Rise Drop
Single Line Symbology
Two Line Symbology
Size
= Conduit Settings
[=)- Rise Drop
Single Line Symbology
Two Line Symbology
Size
Load Calculations
Panel Schedules

Setting Value
Draw MEP Hidden Lines
Line Style MEP Hidden
Inside Gap 1/64"
Outside Gap 1/64"
Single Line 1/64"
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Hidden Line settings for crossed cable tray and conduit objects;

Circuit settings for annotations, and for project wide sizing tools;

Angle settings that are applied to cable tray and conduit fittings

Project wiring settings for tick marks, circuit wire sizing and other annotation settings

Wire size default values based on material, insulation and temperature rating

Correction factors and ground conductor settings for wiring, based on temperature

and ampacity

e Wiring Types that can be assigned to a circuit, and are sized based on the load/breaker
rating

e Voltage definitions that allow a range of assigned voltages (such as 110-130) to be
assigned to a common voltage (120)

o Distribution systems that set the configuration type (wye or delta), phase and number
of wires
Cable tray and conduit routing settings for annotations, rise drop symbols and sizes;

¢ Load calculation settings for enabling the loads to be associated with a corresponding
space, settings for project load classifications, demand factors, and apparent load
calculation methods (including true and reactive load);

o Panel schedule settings that apply to all schedules, including space and spare labels,

load totals and cell formatting.

All of these settings are global to the project; in other words, changing values here
affects all examples of objects, except where object specific overrides are defined.

Defining System Types

Beyond the overall project settings, each class of items include specific settings. Revit begins
with system classifications, which are used to control duct and piping systems. These are hard-
coded items that are associated with the formulas for deriving duct and pipe sizes. While you
cannot edit the system classifications, you can edit the system types using the Project Browser.
Examples of system types would include domestic cold water supply, hot water return, makeup
supply air and more. These should be defined in your template, so the user has a starting point
for their systems.

The equivalent to the system classification for electrical is the distribution system, which based
on the system voltage. Each voltage can be assigned a range, but only items that fall within that
range can be associated with that “voltage” system. Transformers are required to create the
relationship between lower and higher voltage distribution systems.

For all system types, you must have a corresponding connector defined in the target and source
family. Duct, pipe and circuits do not have to be added to create a relationship between the
target and source, but the connectors must use the same type and/or system classification, or
voltage.

Duct System Characteristics

From the Project Browser, expand the Families section. Expand Duct Systems, and select
Supply Air:
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You can edit system types by double-clicking the name, or by using the right click option to
open a menu and selecting Type Properties.

Type Properties *
Family: ‘System Family: Duct System v| | Load |
Type: | Supply Air w | | Duplicate. .. |

| Rename |
Type Parameters
Pararmeter | WValue | =|

Graphic Overrides Edit...
Material -<By Category>
Calculations All
Systern Classification Supply Air
Type Image
Abbreviation
Type Comments
URL
Description
Rise / Drop Symbol Cross
<<previes | ok || canel | Apply

A duct system controls the following items:

o Graphic Overrides — assigned a color, linetype and hatch pattern to the duct and duct
fittings, when the system type is selected;
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Material — assigns the material applied to the duct which controls the color and rendered
surface when using shaded or realistic views;

Calculations — controls whether calculations are performed as the duct is placed, and
attached to target/source equipment. You can choose between All, Flow Only, None and
Performance

System Classification — default setting that controls the calculation method, based on
the type of system, such as supply or return air;

Type Image — location and image file used in a legend to describe the type — note that
the raster image used must be in a location that is accessible to all team members, so
it's best to place these with the project

Abbreviation — used to label the system, such as SUPP for supply air duct

Type Comments — comments that are specific to all examples of the duct system

URL - hyperlink to a website or file, such as a specification for the duct material used for
this system

Description — text value that can be used in a tag or schedule to expand information
that might be included with an abbreviation

Rise / Drop Symbol — displayed on a vertical section of duct, that indicates the type of
duct system

Pipe System Characteristics

Piping systems are also defined in your project template. From the Project Browser, expand
the Families section. Expand Pipe Systems, and select Domestic Cold Water:

= Piping Systems
- Piping System

Domestic Hot Water
Fire Protection Dry
Fire Protection Other
Fire Protection Pre-Action
Fire Protection Wet
Hydronic Return
Hydronic Supply
Other
Sanitary
Vent

You can edit system types by double-clicking the name, or by using the right click option to
open a menu and selecting Type Properties.
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Type Properties *
Family: 'System Family: Piping System v| | Load... |
Type: Domestic Cold Water v | Duplicate. .. |
Type Parameters

Pararmeter | Yalue | =|

Graphic Overrides Edit...

Material -<By Category>
Mechamicll 8

Calculations All

Systemn Classification Domestic Cold Water

Fluid Type Water

Fluid Ternperature 80 °F

Fluid Dynamic Viscosity 1.1211 cP

Fluid Density 62.360000 Ib/ft*

Flow Conversion Method Predominantly Flush Vahees
MentityData &

Type Image

Abbreviation

Type Comments

URL

Description

Two Line Drop Symbol ¥in Yang

Two Line Rise Symbol Outline

Single Line Drop Symbol Bend - 4 Circle

Single Line Rise Symbal Cutline

Single Line Tee Up Symbol Cutline

Single Line Tee Down Symbaol Tee - Half Circle

I - (R

A pipe system controls the following items:

¢ Graphic Overrides — assigned a color, linetype and hatch pattern to the pipe and pipe
fittings, when the system type is selected;

e Material — assigns the material applied to the pipe which controls the color and rendered
surface when using shaded or realistic views;
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e Calculations — controls whether calculations are performed as the pipe is placed, and
attached to target/source equipment. You can choose between All, Flow Only, None and
Performance. The options will vary based on the type of system — for example, Sanitary
does not include an All option, while Other is for non-calculated systems, such as
Compressed Air.

o System Classification — default setting that controls the calculation method, based on
the type of system, such as domestic cold water, sanitary and hydronic supply.

¢ Fluid Type and Fluid Temperature — these options only appear with water and glycol
pressurized systems. This includes domestic water and hydronic systems.

¢ Fluid Dynamic Viscosity and Fluid Density — these settings are determine by the
project fluid settings, and controlled by the temperature assigned to the system. Editing
the temperature and fluid type will change these settings.

¢ Flow Conversion Method — these settings appear as part of the domestic water
systems, allowing you to choose between flush valve and flush tank systems.

o Type Image — location and image file used in a legend to describe the type — note that
the raster image used must be in a location that is accessible to all team members, so
it's best to place these with the project

o Abbreviation — used to label the system, such as DHW for domestic hot water
Type Comments — comments that are specific to all examples of the pipe system

o URL - hyperlink to a website or file, such as a specification for the pipe material used for
this system

o Description — text value that can be used in a tag or schedule to expand information
that might be included with an abbreviation

¢ Rise / Drop Symbols — displayed on a vertical section of pipe that indicates the type of
pipe system, based on single line, two line and tee up/down locations on a pipe.

Electrical System Characteristics

Electrical Systems aren’t developed the same way as duct and pipe. Revit includes a series of
electrical systems that are based on electrical connection settings in a family. Electrical systems
are made of the following types:
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Connector Element (1) ~

Electrical - Loads 2
System Type Power - Balanced |

s F

Properties help Apply

Project Browser - Centrifugal Pump - Horizontal.rfa x
m- 0, Views (all)

Sheets (all)
a2 Families
- [@] Groups

=0 Revit Links

o Power connections — made up of balanced and unbalanced loads, based on single or
three phase systems;

Communication

Control

Data

Nurse Call

Fire Alarm

Security

Telephone

Switch

These are used to define circuits and other relationships, such as communication network or
control system. All non-power electrical systems exist to only show the relationship between a
target, such as flow switch, and a source, such as a control panel.

Power systems are electrical circuits that are based on voltage systems, and provide device
load data that is modified by number of poles, load classification, demand factor and power
factor. The electrical fixture device, or light fixture, typically defines a power system or circuit.
The panel is defined as the source, since it provides the power to the target. A panel can be
both a target and source, but a transformer must be placed in order to connected lower voltage
(120/208, 120/240) to a higher (277/480).

Switch systems are used to associate a primary light switch with light fixtures. Since only one
switch defines a switch system, three pole fixtures are added to a system as another device.
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Creating the Target Source Relationship

MEP systems in Revit boil down to a simple task. A relationship, which is defined by a target, is
established be creating a connection to a source. In traditional CAD documentation, it's
demonstrated by following the routing of duct, pipe and wire between these items. But after the
building is finished, after the slab is poured, the ceilings and wall finishes in place, and the roof
topping the building how, most of these items remain invisible to the occupant.

In Revit, they’re never invisible. This relationship can be made by either routing the duct, pipe or
wire, or by simply using the system tools to create it. There are several key advantages for
using the system tools first:

The best indicator is the tab selection tool, which allows the user to place their cursor
over a device, tap the tab key, and see the structure of the system.

The system can be used for simple duct, pipe and wire layouts, based on preset
preferences for materials and routing elevations.

The system can also be used to control visibility properties throughout a project,
based on system type settings or view filters.

You can select several targets at once, and use them to define a system — for example,
selecting several lights that will all belong to the same circuit saves several steps.

The system tracks the load information from the target devices back to the sources,
exposing overall system data. But a source is not always required...wait...what? We’'ll
come back to this....

While conduit and cable tray geometry can also be added using this system relationship,
let’s focus on the basic MEP connections first.

Defining the System by Target

To create a system in Revit, select any one of these devices:

TdR: Create/Modify  Gannett Fleming = Modify | Air Termina o
0 | B 2 &
v 4 | 3/'1% &
Edit Connec t Air Termina | Duct
Family Int on Duct
Mode | Fabricati Layout Create System

TARGET: AIR TERMINAL — DUCT SYSTEM
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Medify | Mechanical Equipment |

=/

Edit | Designto | Connect | Power Piping
Family | Fabrication Into

Mode | Fabrication | Layout | Create Systems

B
112"
480 Out
1567 WA
Motor

TARGET: PUMP — POWER SYSTEM/PIPING SYSTEM WITH MULTIPLE CONNECTIONS

TR it Ganne g | Moy | i Eqipment [1ICIRI]
=/ IR N O

Edit Create . Edit Power
Family | Panel Schedules Panel Schedule
Mode Electrical Create Systems

Transformer

TARGET/SOURCE — TRANSFORMER (TARGET FOR 480/277V PANEL, SOURCE FOR 120/208V PANEL)
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Meodify | Plumbing Fixtures

= ® B P &

Edit Connect Edit Pick Piping

Family Into | Work Plane | New
Create Systemns

Mode Work Plane Placement
4

. *

"

In

| Plumbing Fixtures : Sink - Service : 22"x19" - Public i

Fabrication | Layout

10.00 FU

TARGET: PLUMBING FIXTURE — SOURCE NOT REQUIRED (I.E. WASTE, FOR A VARIETY OF REASONS)

In all cases, the system is defined by the connector, the role the part plays in the system and
the defined Revit family category.

To create the system, you simply choose the system type from the ribbon. If a part has more
than one connection, such as with the sink, you may be prompted to select the connector and
system type (in this case, piping):

Create Piping System ? et

System type:

System name: Domestic Cold Water
Other

[ | Open in System Editar

o 1| ot |

You would also be prompted to specify a system name, which helps you identify the system in
the project.
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Duct Systems Defined

Once you select the HVYAC component that contains the duct connector, selecting the Duct
system causes the Create Duct System dialog to appear:

Create Duct System ? >

System type: Supply Air e

System name: | Office 5 Supply Air

Open in System Editor

Cancel

When only option, such as Supply Air, is available, it's because the connector has a
preassigned system classification — in this case, Supply Air. If multiple Supply Air systems
are listed, it's because you may have more than one Supply Air duct system defined — but only
systems that are tied to the Supply Air classification can be used.

The only time you will see all system types appear is when the connector is set to Global or
Other.

Here’s an important note: NAME YOUR SYSTEM. This will help you clearly identify what the
target is servicing — such as the OFFICE 5 SUPPLY AIR system name.

Selecting Open in System Editor will open the entire set of system tools. Leaving this option
deselected only opens the Modify | Duct Systems tab of the ribbon:

T4R: Create/Modify  Gannett Fleming = Modify | Duct Systems

éﬁ]ﬂ @- Q

Design to Edit Select Duct Pressure
Fabrication | System Equipment Loss Report
| Fabrication | Systemn Tools | Duct Systemn Reports |

This tool still allows you to edit the system, select the Source Equipment or disconnect
equipment. Based on the connector type, you may also see additional options, such as the Duct
Pressure Loss Report.

If you select the Open in System Editor tool, or the Edit System tool, a new ribbon tab will
appear:
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Modify|||Properties|| [X] Office 5 Supply Air *  Edit  Select
Systemn Equipment

Select | Properties Systern Tools
Fodify | &0k Terminals | FI-::mr:| 500 CFM
Properties x
[@-] Duct System .
Supply Air
Duct System: Office 5 Supply Air ) | Edit Type
Mechanical ]
Murnber of Elermnents 1

System Equipment

System Mame Office 5 Supply Air

Static Pressure 0.0363 in-wg
Mechanical - Flow

Flow :500.00 CFM
Identity Data

Image

o

uy b

Comments

Properties help Apply

DucT SYSTEM TAB

Keep in mind — you can select any target that has been defined to a system after it has been
defined, but you will get two modify tabs:

| T4R: Create/Modify  GannettFleming  Modify | Air Terminals | Duct Systems |
=) B 3¢ &

Edit Design to | Connect Air Terminal | System
Family | Fabrication Into on Duct | Inspector
Mode | Fabrication Layout Analysis

Modify Air Terminals will you get you the Edit Family, Layout and Analysis tools, while Duct
Systems will display the tab above.

Make sure you are selecting the right tab based on the changes you are making!
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The Edit Duct System (or Edit System) tool, located on the Duct Systems tab, opens the
system up for editing:

] =
[ = || &g | Geo @ v K
Madify |[Properties Add Remove Select Finish Cancel
to Systemn|from System | Equipment | Editing System Editing System

Select = | Properties | Edit Duct System | Mode e
System Equipment: MNone w Mumber of Elements: | 1
Properties X
Duct System .
Supply Air

Duct System: Office 5 Supply Air w Edit Type
Mechanical A

System Equiprment

Systern Mame Office 5 Supply Air
Identity Data 3

Image

Comments

This tool allows you to:

e Review and set system properties such as the system name, image and comments that
can be used in a schedule, and edit the system Type, which controls the graphic
overrides, materials, calculations, identity data and rise drop symbols;

e Add other targets to the system (the system type must match);

¢ Remove targets from the system;

Select the Source Equipment from a drop down list or by selecting the equipment family
in the model view;

e See the number of elements that are included in the system;

¢ Finish and Cancel editing the system — note that you HAVE to close this tool by
selecting one of the options before moving on to another task.
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Pipe Systems Defined

Similar to the duct systems, you select the equipment component that contains the pipe
connector, and selecting the system makes the Create Pipe System dialog appear:

Create Piping System ? ot

System type: Hydranic Supply e
L

System niame: Hydronic Return

Sanitary

Dormestic Hot Water
Domestic Cold Water

Fire Protection Wet

Fire Protection Dry

Fire Protection Pre-Action
Fire Protection Other r
Other
Vent

In this case, the connector is set to global, so you can select any system type or classification.
Keep in mind that once the connector is set to a specific system classification, only system
types in the same classification can be used.

As with duct, make sure NAME YOUR SYSTEM to clearly identify what it is servicing.
Selecting Open in System Editor will open the entire set of system tools.

In some cases, if you have more than one connector assigned to the same system

classification, you will be prompted to select a connector — all unconnected connectors will
appear in the list (...get the connection???):

Select Connector: Centrifugal Purnp - Horizontal x

Connactor 2 - Undefined - Round - 1 1/4" - Water/Other uqu.d Out

Conce

Select the connector you wish to use, and then click OK.
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Leaving this option selected opens the Edit Piping Systems tab of the ribbon:

b B = @ v X

Modify ||Properties Add Remove Select Finish Cancel
to Systemn | from Systern | Equipment | Editing System Editing Systemn
Select = | Properties | Edit Piping System | Mode e
Edit Piping System System Equipment: Mone - Mumber of Elements: | 1
Properties X
EDD Piping System .
Hydronic Supply

Piping System: Hydronic Supply 2 ~ Edit Type
Mechanical E

Systemn Equipment

Systern Mame Hydronic Supply 2

Volume Mot Computed
Identity Data A

Image

Comments

Properties help Apply

PIPE SYSTEM TAB

This tool allows you to:

o Review and set system properties such as the system name, image and comments that
can be used in a schedule, and edit the system Type, which controls the graphic
overrides, materials, calculations, fluid mechanical properties, identity data and rise drop
symbols;

e Add other targets to the system (the system type must match);

e Remove targets from the system;

o Select the Source Equipment from a drop down list or by selecting the equipment family
in the model view;

See the number of elements that are included in the system;

¢ Finish and Cancel editing the system — note that you HAVE to close this tool by

selecting one of the options before moving on to another task.
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Keep in mind — you can select any target that has been defined to a system after it has been
defined, but you will get two modify tabs:

[ T4R: CresteMiodify | GannttFleming | Mod  Mechanical Equipmen | Piping ystems
3 LEEN @)

Edit Connect Power

Family Into
Layout | Create Systems

Mode
Modify Mechanical Equipment will you get you the Edit Family, Layout and additional Create
Systems tools (if additional connections are available), while the Piping Systems tab will
display to the right:

H EDu—\ &
b iy System Selector: i Iﬁ'+

Modify|||Properties| (&1 Hydronic Supply 2 *  Edit Select
System Equipment

Fabrication

Select | Properties Systemn Tools

Make sure you are selecting the right tab based on the changes you are making!

Electrical Circuits Defined

Electrical circuits have similar behavior to pipe and duct connectors in that the system (or
circuit) is defined the same way. You select target devices, such as lights, and then use the
Power tool to define the circuit. An option also exists to create a switch system when lighting
fixtures are selected, but that’'s for another lesson.

When the Power system tool is selected, the Modify | Electrical Circuits tab appears:
Nl Gt o Fiming | oy Bl Creurs [INCIRINT]
@ ﬁl' Panel: f(. O—H—J

Edit Select Mone * | Arc  Chamnfered
Circuit Panel Wire Wire
Systern Tools Convert to Wire

The tab includes system tools for editing the circuit and selecting a panel.

Here’s an important feature: If you create a circuit using devices that have the same voltage
definition, the panel selected for the previous circuit will become the default, and the new circuit
will automatically be assigned to that panel.

The tab also includes the option to add arc or chamfer wire to the connected device. The wire
type is determined by the circuit.

When you select the Edit Circuit tool, the Edit Circuit tab appears:
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= || o= B
% = ‘é—i OA: == Panel: w w
Modify ||Properties Add Remove Select  Mone = Finish Cancel
to Circuit| from Circuit | Panel Editing Circuit Editing Circuit

Select = | Properties Edit Circuit ‘ Mode

Edit Circuit | Mumber of Elements: | 6
Properties x

Circuit: <unnamed> | HE] Edit Type
Electrical Engineering &

Schedule Circuit Notes i E ]
Electrical - Loads A

Circuit Number =unnamed:>

Load Mame

Lighting - Dwelling Unit MEETING ...

Panel

Systemn Type

Power

Load Classification

Lighting - Dwelling Unit

Mumber of Poles

i

Rating 2000 4

Frame 400.00 A
Yoltage 120,00V
Yeltage Drop Mot Computed
Power Factor 0.950000
Power Factor State Lagging

Balanced Load

Length Mot Computed
Wire Type THWM

Wire Size 1-#12,1-#12, 1-#12
# of Runs 1

H

of Hot Conductors

1

H

of Meutral Conductors

1

# of Ground Conductors

1

Lighting - Dwelling Unit Connected

430,00 VA

Identity Data
Image

ol

Comments

There’s a lot more detail included in the properties palette, with a large amount of data
determined by the connector in the family and the connected panel. Some information will be
populated by the initial act of creating the circuit, while others are populated when the panel is

selected.

For target devices such as receptacles and lights, the Electrical loads include the following

properties:

e Circuit Number — determined when the panel is selected (note: if a device has more
than one electrical connector, this can cause the Circuit Number value to be blank, and
to incorrectly populate a tag. If you need to have multiple power connections on the
same device, use an external hosted power connection, based on the Revit category for

the part);
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o Load Name - determined by the Load Classification assigned to the electrical
connector, and the Space Name where the device is located (note: the device has to be
completed encompassed by the space in order for this value to be used)

e Panel — determined when the panel is selected.

o System Type — default system type that is assigned by the load classification, and can
be power, lighting or other.

o Load Classification — value associated with the electrical connector, which sets the
demand factor rating, and what load class is used for space calculations, including
power, lighting or other.

o Number of poles — determined by the electrical connector, only devices with the same
number of poles can be assigned to a circuit.

e Rating — circuit specific setting that can be changed, this value is the rating for the circuit
breaker in the panel. The value is not calculated by the circuit tool, so it is up to the user
to review the loads assigned to the circuit, and set the breaker value. This value can also
be changed on a panel schedule.

o Frame — circuit setting that can be changed, this value represents the maximum value a
breaker trip rating can be set to. It is not used in calculation, but will limit the value if the
user tries to change the breaker rating to something greater than the frame allows.

o Voltage — value associated with the electrical connector, this is normally a type value,
and any devices that are added to the circuit must match this value.

o Voltage drop — this value is computed when the circuit is assigned to a panel.

e Power Factor — value associated with the connector, this numeric item is part of the
load calculation for the circuit, and is multiplied times the actual value when the load
classification and demand factor is taken into consideration.

¢ Power Factor State — value associated with the electrical connector, this sets whether
the power values are lagging or leading, and affects the load calculation on the circuit.

o Balanced Load - determined by the connector, this value indicates if the load on the
circuit is balanced across all phases.

¢ Length — determined by the placement of the fixtures relative to the connected panel,
this value shows the overall distance between the farthest device and the panel,
including X, Y and Z axis values.

o Wire Type — defined by the project settings, the user can edit the wire type used by the
circuit. The wire settings will affect the number of tick marks that appear when used, and
will be used to determine the following settings for wire size, # of runs, # of hot
conductors, # of neutral conductors, and # of ground conductors.

¢ Load Classification Connected — defined by the load classification assigned to the
connector, and the defined apparent load assigned to the connector (whether by
instance or type), this value shows the total load by classification that is assigned to the
circuit.

Note that several items have been highlighted in Red — these are electrical connector
parameters that should use an associated parameter, which is assigned to the connector.
When the connector’s parameter is associated with a family or shared parameter, that value
becomes exposed in the project. This allows you to change these values without having to open
the family and edit the connector. When defined as a shared parameter, the value can also be
used in a schedule or tag, and exported to an external database.
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As much information that you see when edit a circuit’s type properties, the properties palette will

display additional instance properties about the circuit from the Electrical Circuits tab.

Electrical - Loads
Circuit Mumber

1

oy
(2l

Load Mame Lighting - Dwelling Unit MEETIM...
Panel LP1

System Type Power

Load Classification Lighting

Mumber of Poles 1

Rating 20,00 A

Frame 400.00 A

Voltage 20,00V

Apparent Load

430.00 VA

Apparent Load Phase A

430.00 VA

l-\.I l-\.I l-\.I (1)

Apparent Load Phase B 0.00 VA
Apparent Load Phase C 0.00 VA
Apparent Current 4.00 A
Apparent Current Phase A 4.00 A
Apparent Current Phase B 0.00 A
Apparent Current Phase C 0.00 A
True Load 456.00 W
True Load Phase & 456.00 W
True Load Phase B 0.00 W
True Load Phase C 0.00 W
True Current 3.80 A
True Current Phase & 3.80 A
True Current Phase B 0.00 A
True Current Phase C 0.00 A
Voltage Drop 0.81v
Power Factor 0.950000
Power Factor State Lagging
Balanced Load

Lenath 52' 915/16"

Three main areas related to the circuit are displayed:

Apparent Load — values are derived from the load on the circuit, as defined by the electrical
connector in the family. If the circuit is a 2 or 3 pole circuit, then the load per phase is displayed.
The value is measure as real and reactive power using Apparent Current X Voltage. The default
units are volt amperes, but other forms can be set on the Manage tab, Settings panel, Project

Units:
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Discipline: Electrical “ | Format X
Units Farmat ~
e
Frequency . 1235 Ha Use project settings
R mm—— s e e 3
Luminance | 1235 cd/m® Watts
Luminous Flux . 1235 Im Rounding: Kilowatts
Lumincus Intensity | 1235 cd i 0 decimal places % ({EF:E:E m::m:: Hg:tt:% E:; E;cu::nd
Efficacy | 1235 Im/W i bol: Calories per second
Wattage E 1235 W kIt S Kilocalories Er second
Color Temperature . 1235 K i IGIoucI:It.-’a%peres
Lo, — R [Jsuppress trailing 0's (Hersspower
[ Apparent Power | 1235 VA ]

. i Suppress 0 feet
Power Density ; 1234.57 W/t
Electrical Resistivity . 1234.5679 ohm-m Show + for positive values
Wire Diameter | 1234.567890" | [Juse digit grouping
L e S
S REeT b Suppress spaces

Decmal symbaol/digit grouping: Cancel
123,456, 789.00 -
T B
Ok Cancel Help

Apparent Current — measured in amps, value derived from the apparent load divided by the
voltage, is based on properties assigned to the connector. Three phase values for Apparent
Current are set by Apparent Load \ (Voltage X v/3).

True Load — measured in watts, this value is derived from the actual power used by the circuit.
The value is measured the formula Voltage X True Current (including by phase)X Power Factor.
True Current — displays the actual current in amps for the circuit, based on values assigned to
the connector, where True Load / Voltage.
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Leveraging Systems for Sizing and Analysis

The key to understanding how to use Revit for duct, pipe and circuit sizing and analysis begins
by understanding how the connectors embedded in MEP families work. When the connector is
not properly defined, the system tools are ineffective. Understanding items such as flow

direction, system settings and associated parameters help the tools work smoothly in a project.

The Connector Rules!

The MEP connector is what separates MEP families from architectural and structural families.
The connector is used to create a starting (or ending) point of a system. Connectors use a
combination of predefined parameters, based on the part type, that setup information for the
sizing and analysis tools. While the connectors each have specific settings, you need to
understand a few rules first.

Flow Settings

In order to understand the best practices for connectors in Revit, you need to understand how
flow is handled. Flow is explained as the movement of air, fluid or power between a source and
target.

Flow direction, a parameter that is assign to a connector, is critical, but may be counterintuitive
to how we think. For example, the suction connection on a pump is considered an “in”
connection, while the discharge connection is out. In this case, the source (pump) is both a
target and source, since it receives fluid and also provides it to other devices. But if you are
connecting a pipe to a target, such as a spray nozzle, the flow direction remains as “in”, since it
is a target of the source. The fluid is not flowing out of the nozzle, but instead is in to the nozzle

from the pump.

Here’s another example from an air system. If you are designing an air handling system, the
source equipment is providing air out to a target, while the target is receiving air into the
terminal or equipment:

FLOW in REVIT

Terminal Unit -
VAV, FCU, etc.

Even though we think of air flowing out of the air terminal into the room, this is not how Revit
treats the interaction. Most system errors we have encountered have occurred were a result of
flow direction being mislabeled, so make sure you understand this behavior first.
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Connector System Relationships/Associated Parameters

With all connectors, you have a couple of options. You can predefine a system classification,
such as supply air, domestic cold water, or balanced power. In some cases, a global or other
option will be available. While it's a best practice to use a predefined system, you may have
some parts that are used across several system types. When a connector, such as a pipe or
duct connector is assigned as global, the initial connection defines the system classification.

Example: If you select the duct tool, and then set the system to Supply air, if the connector is set
to global, then the system is defined as supply air. You could use the same family again,
selecting Return air as the system — when you select the connector, the system will be assigned
as return air.

The scenario for using a global connection is when you are NOT performing air flow calculations
in a Revit model. Since the connector is global, some settings, such as loss method, loss
coefficient, and more cannot be used, since these are specifically related to the connector in the
part.

The way to check this? Review the properties of the part — if there is an associate parameter
icon next to the parameter, the data can be exposed and edited in the Revit project file:

Mechanical S
Flow Factor

Non-associative parameters

> — can only be changed by
editing the family

Lozs Coefficient

Flow Configuration

Flow Dhrection

Systemn Classification Supply Air
Loss Method Specific Loss

Mechanical - Flow T Associative parameters — can
Pressure Drop 0.0563 in-wg C be changed by editing the family
Flaw =00.00 CEM C or editing the instance/type

value in a project
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Understanding Connector Types

The connector is always defined in a family, and includes several properties that must be
correctly defined in order for a system to work correctly.

Let’'s examine the main connector types:

The Duct Connector

Connector Element (1) - M

Dimensions A .

Shape Rectangular A /O’f +
Height T 0 ‘,/;,/)

Width "0

A

Mechanical
Flow Factor
Loss Coefficient

Flow Configuration

Flow Direction

System Classification Return Air

Loss Method Specific Loss *
Mechanical - Flow
Pressure Drop

Flov v

dentity Data A
Utility ‘0
Connector Description

Properties help Apply

N

The duct connector is assigned by system classification first, such as Supply, Return and
Exhaust air. It can also be set to Other Air or Global (which includes the same parameters as
the first three, but is not calculated in a model). Other Air allows any system classification to be
associated with the duct connector — but once it is set, it cannot be changed to a different
system classification — only a different type within that system classification.

One note about connectors — if the system classification is set to global or other, Revit will use
the last system type that was added in the model, as the default type, when the Add Duct grip is
used to place a duct. Always check your system type first on your connector first when using the
grip — or use the Add Duct tool from the ribbon, and select the system type you want to use prior
to placing the duct.

Duct connectors can be defined as rectangular, round or oval shapes.

Duct connections can be linked together, such as those in a terminal unit.

The connection includes built in parameters for the following mechanical properties:
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Connector Element (1)

Dimensions
Shape

o d

Height

Rectangular
o

Width

Diameter

Mechanical
Flow Factor

Loss Coefficient

Flow Configuration

Flow Direction

Systemn Classification

Supply Air

Loss Method

Specific Loss

Mechanical - Flow
Pressure Drop

N NGAD
UU3b In-wg

Flow

500.00 CFM

|dentity Data
Utility

L]

Connector Description

Flow Configuration — Select from three values — Preset, System and Calculated, for
measuring airflow in duct sizing

Flow Factor — this percentage of system flow is used when the flow configuration is set
to System.

Loss Coefficient — value becomes active when the loss method is set to Coefficient.
Flow direction — sets the flow direction relative to the connector — In, Out and
Bidirectional

System Classification — default system values for supply/return/exhaust/other/global,
or fitting depending on family type

Pressure Drop — value becomes active when the loss method is set to Specific Loss

Flow — default value assigned to the connector for air flow, and is included in the system
properties.
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The Pipe Connector

Connector Element (1) ~ Edit Type
Dimensions H]
Radius {0 05/8" =
Mechanical H]
K Coefficient 0.000000
Flow Factor 0.000000
Flow Configuration Calculated
Flow Direction Out
Loss Method Not Defined
Allow Slope Adjustments O
System Classification Global
Mechanical - Flow H]
Flow :0.000 GPM iE
Pressure Drop 10,000 psi
Identity Data I
Utility H EE
Connector Description {Water/Other Liquid Out D
Properties help Apply

Changing the connector can change the available properties:

R

ECDnnectnr Element (1) i I EE Edit Type
Dirnensions A
Radius 0’ 05/8" =
Mechanical ]
K Coefficient 0.000000
Flow Factor 0.000000
Flow Configuration Calculated
Flow Direction Out
Loss Method Mot Defined
Allow Slope Adjustments 1 L__]
System Classification Sanitary
Mechanical - Flow 3
Fiture Units 0.000000
Flow 0.000 GPM [j
Pressure Drop 0.000 psi

SANITARY PIPE CONNECTION
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Cennecter Element (1) v | BEl

>

Dimensions

| Connector Elerment (1)
ELCTidrircdr

» i

K Coefficient

Flow Factor
Flow Configuration Calculated
Flow Direction Out
Loss Method Mot Defined
Allow Slope Adjustments [&=]
System Classification Hydronic Supply w
Mechanical - Flow 3
Flow 0.000 GPM
Pressure Drop 0.000 psi
Identity Data 4
Utility O
Connector Description Water/Other Liquid Out

HYDRONIC SUPPLY PIPE CONNECTION

Pipe Fittings require their own connector:

Connector Element (1) e

Constraints
Angle :0.00°
Dimensions >

o

Radius

=
=
(]
fes]

Mechanical b

Systern Classification ‘Fitting

Using an incorrect system classification on a fitting can impact the correct behavior of the part,
such as not allowing the pipe to deflect in small angles, such as with mechanical joint
connections that flex when placed underground.

Pipe connections can also be linked to each other. This only occurs when the connector is set
to global, and works best with inline components such as valves. The system type, flow
direction and flow values are carried from one connector to the next in a family when they are
linked. Either connector in a family can be designate as the primary, which also establishes the
direction a part will be placed during layout. The primary connector should always be placed on
the X-Axis in a family, when defining fittings.

The connection includes built in parameters for the following mechanical properties, which vary
based on the type of system classification and flow configuration:
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Connector Element (1)

Dhmensions
Radius

Mechanical
K Coefficient

nnnnnnnnnn
uuuuuuuuuuu

Flow Factor

uuuuuuuuuu

Flow Configuration

Firture Units

Flow Direction

In

Loss Method

Specific Loss

Allow Slope Adjustments

&

Systern Classification

Domestic Cold Water

Mechanical - Flow
Fisture Units

F o

Pressure Drop

Identity Data
Utility

Connector Description

Radius — size of the connection — can be set to measure as diameter or radius

K coefficient — value is used when loss method is set to K coefficient

Flow Factor — value is used with flow configuration is set to system, measures
percentage of system flow from connector

Flow Configuration — predefined values for calculated, preset, system and fixture units
form of measurement, for pipe sizing

Flow Direction - sets the flow direction relative to the connector — In, Out and
Bidirectional

Loss Method — measures pressure loss based on specific loss, K coefficient, or not
defined

Allow slope adjustments — toggle that allows connected pipe to include a non-
perpendicular connection

System Classification - default system values for domestic hot/cold water, sanitary
waste/vent, fire protection, hydronic, other global or fitting, depending on family type and
use

Fixture Units — used with sanitary, vent, and domestic water systems when the flow
configuration is set to fixture units

Flow — value measured as volume rate for fluids

Pressure Drop — calculated pressure drop based on settings defined for Mechanical
Settings for a project

Utility — toggle that defines a connection to a site utility, when exported as an ADSK file
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Electrical - Loads
System Type

»

Power - Unbalanced

Mumber of Poles

1

Power Factor State

Lagging

Load Classification

Lighting - Dwelling Unit

Load Sub-Classification Mot...:[ ]
Voltage 277.00V =
Apparent Load Phase 1 20.00 VA =
Apparent Load Phase 2 0.00 VA
Apparent Load Phase 3 0.00VA
Power Factor 0.950000

Identity Data Y
Utility [l

Connector Description

Properties help

Apply

The electrical connector includes a wide range of power and non-power electrical categories,
but only the power connections track load. Changing the connector changes the available

properties:
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Connector Element (1)

Electrical - Loads
Systern Type

o

Power - Balanced

Mumber of Poles

Power Factor State

Lagging

Load Classification

Lighting - Dwelling Unit

Load Sub-Classification Mot...

L

Voltage

0.00 VA

Apparent Load
Power Factor 0.950000

Identity Data 3
Utility []

Connector Description

Balanced power assumes the apparent load is evenly distributed between the poles, while un-
balanced power allows the user to assign load individually to each phase.

o System Type — defines the type of electrical connector

¢ Number of Poles — number of electrical pole connections in a panel— 1, 2 or 3

¢ Power Factor State — Lagging (inductive loads where current lags voltage) or Leading
(capacitive loads where current leads voltage) value

¢ Load Classification — specifies the primary power classification related to demand
factor, including HVAC, Power, Lighting and more — can be defined by the user

¢ Load Sub-Classification Motor — yes/no parameter that defines whether a load
classification is associated with a motor

¢ Voltage — sets the voltage rating for the connector, such as 120, 208, 277, 480

o Apparent Load (by phase) — calculated based on voltage x current, active when
Power-Balanced is selected — when Power-Unbalanced is the assigned system time,

apparent load per phase 1, 2 and 3 is available

o Power Factor — numeric value assigned to connector and multiplied to the apparent

load value

o Utility — indicates is a connector is designated as an ADSK connector element, allowing
connections to site utilities in other programs that can read/import ADSK files

o Connector Description — common with all connectors, is used to add a description to
the connector, helping identify connectors — especially helpful when multiple connectors
of the same type are used in a family.
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Connector Element (1)
Electrical - Loads
Systern Type {Data ok
Identity Data
Utility 1

Connector Description

Non-power connections, such as data, nurse call, communication, controls, security, fire alarm
and telephone only carry a connector description.
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Sizing Tools in Revit

Systems are defined by a target (or multiple targets) but work best when associated with a
source. Revit includes several tools that can used to size pipe, duct and wiring. Prior to using
the sizing tools, there are a few rules you need to know about each tool.

Duct Sizing
Duct can be sized using two different methods — friction loss and/or velocity sizing.

HVAC Supply, return and exhaust systems are sized based on the combination of project
mechanical settings (air density, dynamic viscosity and calculation method for straight segment
pressure drop), duct system settings, duct properties, and connector properties.

To size a duct:

You must have the system defined between a target and source;

The connector properties must include the proper values;

The system type must have calculations enabled, and mechanical properties assigned;
The sizing tools do not work on an “other” duct system — it is designed to work only with
pressurized systems.

1. Once the settings are defined, select a duct in a run. You can also select an entire run
by placing your mouse over a duct, and then tapping the tab key (without moving the
mouse).

2. When the entire run is highlighted, you select with the left mouse button.

3. The Duct/Pipe Sizing tool will appear on the ribbon, Modify tab, Analysis panel:

Ao I <= I8

Designto | Routing | Justify Change Reapply | Duct/Pige | Filter
Fabrication | Solutions Type  Type Sizing

Fabrication | Layout | Edit | Analysi

~— =

P
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4. The Duct Sizing dialog will appear, if duct is selected:

Sizing Method

Velocity v| [1000FPM

{®) Only () And O or

0.10 in-wg/100ft

Constraints
Branch Sizing:
Calculated Size Only e
[ ] Restrict Height: 95"
] Restrict Width: 96"
QK Cancel Help

5. The dialog allows you to select the sizing method and default value. It also allows you
to choose between one method, both methods, and an “or” option for either type.

6. Constraints place limits on branch sizing, allowing you to choose between the
calculated size only, matching the connector’s assigned size, or the larger of the
connector size and calculated value:

Constraints

Branch Sizing:
Calculated Size Onhy

Match Connector Size
Larger of Connector and Calculated

7. You can also restrict sizing to a specified value that sets the absolute limit of a duct
height and width size.

Pipe Sizing

Pipe can also be sized using two different methods — friction loss and/or velocity sizing.
Domestic Cold Water systems which include fixture units are converted to flow (gpm/Ips, etc.)
using a general conversion method based on the 2006 International Plumbing Code, Table
E103.3. You must specify a flow conversion method in a pipe system’s type properties, as we
covered earlier. This can be set to predominately flush valve or flush tank toilets.
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To size a pipe:

¢ You must have the system defined between a target and source;
The connector properties must include the proper values;

o The system type must have calculations enabled, and fluid mechanical properties
assigned;

e The sizing tools do not work on a Sanitary (gravity) pipe system — it is designed to work
only with pressurized systems.

1. Once the settings are defined, select a pipe in a run. You can also select an entire run
by placing your mouse over a pipe, and then tapping the tab key (without moving the
mouse).

2. When the entire run is highlighted, you select with the left mouse button.

3. The Duct/Pipe Sizing tool will appear on the ribbon, Modify tab, Analysis panel:

Modify | Multi-Select I Piping Systems -

Design to

Fabrication

Create Fabrication
,4 EE] - 4q w . B ; ] * - .

4. The Pipe Sizing dialog will appear, if pipe is selected:
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Pipe Sizing x

Sizing Methed

Velocity | |4FPS
(®) Oy () And i0r

2.50 FT./100f

Constrairts

Branch Sizing:
Calculated Size Only e

[ | Restrict Size: g

Carcel Help

5. The dialog allows you to select the sizing method and default value. It also allows you
to choose between one method, both methods, and an “or” option for either type.

6. Constraints place limits on branch sizing, allowing you to choose between the
calculated size only, matching the connector’s assigned size, or the larger of the
connector size and calculated value:

Constraints

Branch Sizing:
Calculated Size Onhy

Calculated Size On
Match Connector Size
Larger of Connector and Calculated

7. You can also restrict sizing to a specified value that sets the absolute limit of a pipe
size.
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Wire Sizing

Sizing wire in Revit is a completely different ballgame that duct or pipe. The program performs
the calculations based on circuit protection, voltage drop and correction factor settings. The
following rules apply for sizing wire:

o The device has to be assigned a circuit, and then connected to a panel
The devices on the circuit must have load assigned to connector, and have number of
poles, load classification, demand factor and power factor defined;

o The wire types must be defined in project MEP settings, including the material,
temperature rating, insulation, number of wires, ground conductor option, and correction
factor.

o The circuit breaker on the panel must be set to a specific rating

e The project must have the correct ambient temperature rating

¢ Circuit Length is calculated based on distances from the farthest device based on X, Y
and Z axes.

¢ Voltage Drop will be automatically calculated once the devices on the circuit are
connected to the panel.

¢ Finally, the wire type must be assigned using the Circuit Properties — the wire will be
sized based on the circuit properties described above.

To size the wire, review the wire types first, under the Manage tab, Settings panel, MEP
Settings tool — click Electrical Settings.

Select Wiring Types under Wiring:

Hidden Line

General N Material Temperature Insulati Max Meutral Neutral Neutral Conduit ~
Angles ame atena Rating (*C) neuiation Size | Multiplier | Required Size Type
Wi i

_"”'”Tﬂire s 1 |[THWN Copper (6D THWN 12000 1.00 Hat Conduct : Non-Magnetic
Comection Factor 2 |XHHW Copper 60 KHHW 2000 i1.00 Haot Conduct : Mon-Magnetic
Ground Conductors

Wiring Types
Voltage Definitions
Distribution Systems

From here, you can edit specific values under each column, including

¢ Name — usually based on the insulation value, this can be any value, as long as the user

know what the specific settings are for the type.

Material — wire material, either copper or aluminum

Temperature Rating — maximum temperature rating of wire material

Insulation — insulation material used for wire, can select from a default list

Max Size — maximum conductor size — measure in MCM, controls when wires start

being sized in parallel runs rather than increasing the wire size; based on cross sectional

area rather than ampacity

¢ Neutral Multiplier — all neutral fields control how the neutral conductor will be sized —
increases or decreases size, allows for larger size
Neutral Required — determines of all wires of this type include a neutral

¢ Neutral Size — allows user to set size based on the hot conductor or by unbalanced
current
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¢ Conduit Type — steel or non-magnetic, the material can affect the impedance of wire

A Revit project includes the following default settings:

Wire Impedance Factors:

‘Conduit Wire Size Three Phase Single Phase
Power Factor (%) 100 100

Steel 14 5.369 4.887 4371 3848 3322 62 5643 5047 4444 3836
12 3.464 3.169 2841 2508 2172 4 3659 3281 2897 2508
10 2078 1918 1.728 1.632 1334 24 2214 1995 1769 154
8 135 1264 1.148 1.026 09 156 1.46 1.326 1184 1.04
6 0.848 0.812 0.745 0.673 0.597 098 0.937 0.86 0777 0.69
4 0.536 0.528 0.491 0.45 0.405 062 0.61 0.568 0519 0.468
3 0.433 0434 0.407 0.376 0.341 05 0.501 047 0.434 0.394
2 0.346 0.354 0.336 0312 0286 04 0.409 0.388 0.361 0.331
1 0277 0292 028 0.264 0245 032 0.337 0324 0.305 0283
1/0 0.207 0228 0223 0213 02 024 0263 0258 0.246 0232
2/0 0.173 0.196 0.194 0.188 0178 02 0.227 0.224 0217 0.206
3/0 0.136 0.162 0163 018 0154 0.158 0187 0188 0184 0178
4/0 0.109 0.136 0.14 0.139 0.136 0.126 0.157 0.162 0.161 0.157
250 0.093 0.132 0.128 0.129 0.128 0.108 0.142 0.148 0.149 0.148
300 0.077 0.108 0115 0117 0117 0.09 0125 0.133 0135 0.135
350 0.067 0.098 0.106 0.109 0.109 0.078 0113 0122 0126 0126
400 0.06 0.091 0099 0.103 0104 007 0105 0114 0118 012
500 0.05 0.081 0.09 0.094 0.096 0.058 0094 0104 0109 0111
600 0.043 0.075 0.084 0.089 0.092 0.05 0.086 0.097 0.103 0.106
750 0.036 0.068 0078 0.084 0.088 0042 0.079 0.091 0.097 0102
1000 0.031 0.062 0.072 0.078 0.082 0.036 0.072 0.084 0.09 0.095

Non-Magnetic 14 5.369 5876 4.355 383 3301 62 563 5.029 4422 3812
12 3464 3.158 2827 2481 2153 4 3647 3264 2877 2486
10 2078 1.908 1714 1516 1.316 24 2203 1.98 1.751 1.52
8 135 1.255 1134 1.01 0882 1.56 1.449 1.31 1.166 1019
6 0.848 0.802 0731 0657 0579 098 0.926 0.845 0.758 0.669
4 0536 0519 0479 0435 0388 062 0.599 0553 0.502 0448
3 0.433 0425 0395 0.361 0324 05 049 0.456 0417 375
2 0329 033 031 0.286 0259 038 0.381 0.358 033 03
1 0259 0268 0255 0238 0219 03 0.31 0295 0275 0253
10 0.207 0.22 0.212 0.199 0.185 024 0.254 0.244 0.23 0214
210 0173 0188 0183 0174 0163 02 0217 0211 0201 0188
3/0 0.133 0.151 0.15 0.145 0.138 0.154 0.175 0173 0.167 0.159
4/0 0.107 0.127 0.128 0.125 0121 0.124 0.147 0.148 0.145 0.14
250 0.09 0.112 0114 0.113 0.11 0.104 0.129 0.132 0.131 0.128
300 0.076 0.099 0.103 0.104 0.102 0.088 0.114 0119 0.131 0.128
350 0.065 0.089 0.094 0.095 0.094 0.076 0.103 0.108 0.11 0.109
400 0.057 0.081 0.087 0.089 0.089 0.066 0.094 01 0.103 0.103
500 0.046 0.071 0.077 0.08 0.082 0.054 0.082 0.09 0.093 0.094
600 0.039 0.065 0.072 0.076 0.077 0.046 0.075 0.083 0.087 0.09
750 0.032 0.058 0.065 0.07 0.072 0.038 0.067 0.076 0.08 0.083
1000 0.025 0.051 0.059 0.063 0.066 0.03 0.059 0.068 0.073 0.077

Page 39



- AUTODESK UNIVERSITY

Wire Types:

cnpper
60C 75C %0¢ 60C 75C 90C
™ FEPW T~ ™w RH TA
UF RH TBS UF RHW T8S
RHW SA THHW SA
THHW sis THW sis
THW FEP THWN THHN
THWN FEPB XHHW THHW
USE M USE THW-2
zw RHH THWN-2
RHW-2 RHH
THHN RHW-2
THHW USE2
THW-2 XHH
THWN-2 XHHW-2
USE-2 Zw-2
XHH
XHHW
XHHW-2
w2

Wire Sizes:

Temperature Rating

Aluminum

Temperature Rating

60C 75C 0C 60C 75C 0cC

TA, TBS, SA, SIS, FEP, FEPB, M,
RHH, RHW-2, THHN, THHW,
THW-2, THWN-2, USE-2, XHH,
XHHW, XHHW-2, ZW

TA, TBS, SA, SIS, FEP, FEPB, ML,
RHH, RHW-2, THHN, THHW,
THW-2, THWN-2, USE-2, XHH,
XHHW, XHHW-2, ZW

FEPW, RH, RHW, THHW,
THW, THWN, USE, ZW

FEPW, RH, RHW, THHW,
THW, THWN, USE, ZW

16 - - 18 - - — 16
14 15 15 15 = = = 14
12 20 20 20 15 15 15 12
10 30 30 30 25 25 30 10

8 40 50 55 30 40 45 8

6 55 65 7% 40 50 60 6

4 70 85 95 85 65 16 4

3 85 110 110 69 re) 85 3

2 95 115 130 75 S0 100 2

1 110 130 150 a5 100 115 1

0 125 150 170 100 120 135 0

00 145 175 195 115 135 150 00
000 165 200 225 130 155 175 000
0000 195 230 260 150 180 205 0000
250 215 255 290 170 205 230 250
300 240 285 320 190 230 255 300
350 260 310 350 210 250 280 350
400 280 335 380 225 270 305 400
500 320 380 430 260 310 350 500
600 355 420 475 285 340 385 600
700 385 460 520 310 375 420 700
750 400 475 535 320 385 435 750
800 410 490 555 330 395 450 800
900 435 520 585 355 425 480 900
1000 455 545 615 375 445 500 1000
1250 495 590 665 405 485 545 1250
1500 520 625 705 435 520 585 1500
1750 545 650 735 455 545 815 1750
2000 560 665 750 470 560 630 2000

Wire Size Correction Factors:
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Ambient Temperature C Ambient Temperature F 60 C 75C s0cC
21-25 70-77 1.08 105 104
26-30 78-86 1 1 1
31-35 87-95 091 094 096
36-40 96-104 082 088 091
41-45 105-113 071 0.82 087
46-50 114-122 0.58 075 0.82
51-55 123-132 041 067 0.76
56-60 132-140 - 0.58 071
61-70 141-158 - 033 058
71-80 159-176 - - 0.41

Ground Wire Sizing:

Size Copper Aluminum Size Copper Aluminum
14 15 - 250 2000 1200
12 20 15 300 2000 1200
10 60 20 350 2500 1600
8 100 60 400 3000 2000
6 200 100 500 4000 2000
4 300 200 600 5000 3000
3 400 200 700 5000 3000
2 500 300 750 5000 3000
1 600 400 800 6000 4000
1/0 800 500 900 6000 4000
2/0 1000 600 1000 6000 4000
30 1200 800 1260 6000 5000
4/0 1600 1000

ize (AWG/kemi
14 0.064080 0.0032250357 300 0.5477226 0.2356194490
12 0.080810 0.0015288468 350 05916079 02748893572
10 0.101900 0.0081552613 400 0.6324555 0.3141592653
8 0.128500 0.0129686799 500 0.7071068 0.3929660816
6 0.162000 0.0206119720 600 0.7745967 0.4712388980
4 0.204300 0.0327813057 700 0.8366600 0.5497787144
3 0229400 0.0413310408 750 0.8660254 05890486225
2 0.257600 0.0521172118 800 0.8944271 06283185307
1 0.289300 0.0657664432 900 09486833 0.7068583471
0 0.324900 0.0829065680 1000 1 0785398163
00 0.364800 0.1045199453 1250 1.118034 0.981747704
000 0.409600 0.1317678350 1500 1.224745 1.178097245
0000 0.460000 0.1661901110 1750 1.322876 1.374446786
250 05 0.19634954085 2000 1.414214 1.570796327
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References:

Since the amount of detail needed to cover all aspects of wire sizing is more in depth that we
have time to cover in the lab, follow this link for the full reference of wire sizing in a Revit project:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-0F801DCD-18CD-4B7A-AG4F -
D4D9ESA4CEA9

Also, you can access information about pipe sizing from this link:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-687B295F-42A9-400E-B3E3-
D8977F53DDFF

Piping pressure drop calculation methods are located here:

http://help.autodesk.com/view/RVT/2017/ENU/?guid=GUID-B3A3BB94-5223-4318-8DB4-
E1CDE85C62EQ

For duct sizing, you can find more information here:

http://help.autodesk.com/view/RVT/2017/ENU/?quid=GUID-99B57EF9-BBDD-4C34-8AE2-
S50EAGAE446E7
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Key Tips and Benefits

Systems provide greater benefits that sizing duct, pipe and wire, or tracking load. Systems can
help you select items easily, and can also be used to help quickly create groups. You can also
control object display in a view using the Filter tool using a system, and can associate data from
system objects with spaces. We will wrap this session up by taking a quick look at leveraging
the systems for these actions.

Selecting Systems

If you’'ve worked with AutoCAD or Revit for a while, you have an idea of how items are selected.
Left mouse click selections are common, along with crossing and selection windows. Revit has
had a selection method that takes you beyond the left mouse click to a multiple object selection
method that doesn’t require dragging a mouse across the screen — but it can take a little
practice.

The TAB selection method is accomplished by hovering your cursor over an object, and then
tapping the TAB key to cycle through selection options. When using this over a wall, the
program will start by highlighting the first object the cursor is placed over. A second tab
highlights all of the connected walls, creating a great selection set for adding a roof or slab.

TAB selection works the same way with MEP systems. The first TAB highlights the MEP object,
then cycles through the connected devices. Here’s the best part — if you defined your systems
prior to adding duct, pipe or wire, the second TAB highlights all devices connected in a system
or circuit. Continuing to press the TAB key will cycle through higher level systems, systems
associated with additional connectors in a model, and previews for duct, pipe and wire layouts
that can be generated by the system settings.

Here are some examples of tab-selected systems:
H | | |

T T al
1 I | I

Electrical Circuits : <unnamed>

N

L L/
\;T—\—_f—r——j——u— X%L‘
A

b d b d !

LIGHT FIXTURES CONNECTED ON SAME CIRCUIT, WITH WIRING PREVIEW ICONS
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| Piping Systems : Piping Systemn : Hydronic Supply 2 i

71

[
[
[
[
I
[
[
[
[
[
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[
[
[
I
[
[
[
[

_————ad

A

AIR SYSTEM WITH UNCONNECTED DUCT
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PARTIAL TAB SELECTION OF DUCT SYSTEM

Leveraging Systems for View Filters

A key benefit for defined systems in a Revit model includes the ability to control the visibility of
associated objects by the system definition. A view filter applies a series of rules based on
system properties, and allows you to control the visibility of duct, pipe and electrical items.

To use the filter, open the tool from the View tab, Graphics panel, Filters tool:

s [ @ =

Modify View _ Visibilityq Filters | Thin
Templates Graphicyg Lines

Select « | Graphics

The Filters dialog appears:

Filters
Filters Categories

= Rule-based Fitters Select one or more categories to be

....... Domestic induded in the filter. Parameters
D ic Cold W common to these categories will be
"""" omestic available for defining filter rules.
------- Domestic Hot Wa. ..
....... Hydronic Filter list: ‘ <show all> y
"""" Interior [JHide un-chedked categories
------- Mechanical - Exha...
....... Mechanical - Bet [ Air Terminals "
....... Mechanical - Sup... -] Analytical Beams
....... Sanitary - [] Analytical Braces
....... Vent - [] Anatytical Columns
....... Selection Fiters -] Analytical Aoors
----- [] Anahtical Foundation Slabs
----- [] Analytical lsolated Foundati..
..... Anahdi i
< s [] Anahtical Links o
< >
£ #
] l'—D ] Chedk all Check Mone

[ oc |

&l_ Q ooo
N 1]
Cut Render Render iD=
Profile in Cloud Gallery | View
il
x
Filter Rules
Filter by: |System Classification
contains -
|sup1:'|¥
And: (none) v
and: | {none)
Cancel Apply Help
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The dialog includes three main areas:

Filters — defines rule or selection based filters;

Categories — defines what objects the filter will be applied to;

Filter Rules — defines the rule based on the Revit tool, and what criteria define the rule.

There are two types of filters — rule-based and selection filters.

Rule-based filters can be defined by selecting an existing filter and duplicating it, or by creating
a new filter.

To base a rule on a system type, select one of the existing examples, such as Mechanical —
Supply. Right click and select Duplicate.

Filters Categories

[=]- Rule-based Filters Select one ar more
induded in the filte

Domestic common to these o
Domestic Cold W... available for definir
Domestic Hot Wa...

Hydronic Filter list: | <show ;
Interior [ | Hide un-checker

Mechanical - Bda...

Mechanical - Ret... L1 Air Temin
Mechanical - Sup. [ Anahtical

SEI’I"ZEF}" Duplicate
Vent Rename
Selection Fiters
Delete
[ T ARl

Once the new filter is defined, you can rename it, such as HVAC Supply — Makeup Air.

The advantage to duplicating an existing filter is that the categories and filter rules are already
defined, so it’s easier to modify. Review the categories, where specific duct categories are
selected, and then review the rule.

Selecting System Type changes the rule to match the type, which is the most likely item to be
modified by a user. Select the rule and choose between the following options:

Filter Rules

Filter by: | System Type e

eguals e

= ]Lals
does not equal
contains
. |does not contain
And: begins with
does not begin with
ends with
does not end with

When you select an item such as equals, you can then select the list of available system
types, where the System Type must exactly match this criteria:
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Filter Rules
Filter by: | System Type e
equals e
e
Exhaust Air

And: |Exhaust Air - Fume Hood
Exhaust Air - Hazardous
Exhaust Air - Frocess
Exhaust Air - Vent
Return Air

Sl Air

L
Supply Air - Cutdoor Air

The filter tool allows up to three different rules to be applied, so it could be a good idea to add
rules for items such as System name, type mark and more.

Filter Rules
Filter by: | System Type w

equals -

And;

Assembly Code
Assembly Description
Assembly Name
Comments

Cost

Description

Farmily Mame
IfcGUID

Keynote
Manufacturer

Mark

Model

System Abbreviation
System Classification
System Mame
System Type
Type Comments I
Type IfcGUID
Type Mark
[Type Marme

URL

<More parameters...>

incel

e

The other filter type includes a selection filter. This method works by letting the user select
items in a system, using the tab selection method (or any other selection method), and then
using the selection edit tool to create the filter.
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For example, you can use tab selection to pick all of the items in a piping system. Once the
items are selection, click Manage, Selection and Edit. :

Manage Modify | Multi-Select  Piping Systems
m Structural Settings - % @ Location Manage Images
MEP Settings - Coordinates = Decal Ty
i Purge Project ngs Additional | IA‘ cordinates Design Manage I_E‘t_l: ==VES -
idards Unused Units | [ Panel Schedule Templates = Settings | (& Position - Options  Main Model v | Links [ Starting View i Edit
| Project Location | Design Options | Manage Project | Phasing | Selection |

®C

The Edit Filters dialog appears, and you can choose to create a rule based filter or selection
filter. Click Selection Filter and then click New:

K2

e

Edit Filters >
= Rule-based Fitters Mew. ..
------- Domestic
------- Domestic Cold Water Edit...
------- Domestic Hot Water
....... Hydranic Rename...
....... |nteriur

Delete

I R

The Filter Name dialog appears, so add a name, such as Hydronic Piping System 1:
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Filter Mame X

Mame: | Hydronic Fiping System 1| |

() Define rules
() select

(®) Uze current selection

Conce

You can then choose to define the rules, select a new group of items or use the current
selection.

If you select the last option, the filter will become available under selection filters, and can be

reused. When you return to the Filters dialog, the selection is available from the dialog, but the
categories and rules are set by the selection set.

Filters Categories Filter Rules

—|-- Rule-based Fitters Select one or more categories to be

& r )
induded in the filter. Parameters System Classification

Domesti
Dl::me !c: Cold W common to these categaries will be —
Du::mestlc Hot W available for defining filter rules. CONLEIns
omestic Hot Wa...
Hydronic Filker ist: | <show all> supply
Interior Hide un-checked categories - z
Mechanical - Bxda... And: {nane)
Mechanical - Ret... L1 Air Teminals ”
Mechanical - Sup... L1 Analytical Beams
Sanitary [ Analytical Braces
terst [ Analytical Columns
Vent [0 Analytical Foors :
= Selection Fiters [ Anahytical Foundation Slabs Aind: - [AonE}
Hydronic Piping Syste [0 Anabytical lsolated Foundati.
( 5 [ Analytical Links i
£ >
B T oy
0 0 3 Chedk all Chedk Mone
QK Cancel Apply Help

Here’s where this gets fun — a quick way to select this group again, is to use the Selection,
Load tool to reselect the same items (you can also run this tool from the Manage tab):
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o g =BG ds T | &
a J R

- % Load
= to | Duct/Pipe | Filter | ™~
i Fabrication |  Sizing {al} Edit
View Measure Create Fabrication | Analysis Selection

ey e

Retrieve Filters X

»
» |

It doesn’t matter what view you are in when you load the selection filter — the items will remain
highlighted, so changing to another view, such as a 3D view, will keep the items selected:
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L System Selector: E-Dm-z} @ I@-

Modify| |P es| | (21 Hydronic Supply 1 ~  Edit  Select Disconnect
System Equipment Equipment
Select | Properties System Tools
o s [sommons
Properties X -
. ‘ . S . . . . v o . -
CD:] Piping System B o 0 . Lo . N - . *
Hydranic Supply : R S S
. 5 (2 Edi L T
Piping System: Hydronic Supply 1 V|Ed"T!c'F’e ' P

Mechanical Ol R P
Number of Elements 1 ’

Piping Systems [}

§yetem Equipment 115 Ealion

System Rame Fydironic Supply 1
Tolume 15 gai

Static Pressure fot Computed
Mechanical - Flow A
Flow £0.000 GPM |
Identity Data A
Image ] ]
Comments {

Properties help Apply

Project Browser - 19658L-MEP.rvt X
(=) Elevations (Building Elevation)
..... East - Mech
----- North - Mech

>

(= Plumbing
(=} Plumbing
= Floor Plans
PIPE FIRST FLOOR
- 3D Views
3D Plumbing
=) Elevations (Building Elevation)
East - Plumbing
..... North - Plumbing
..... South - Plumbing
..... West - Plumbing

Schedules/Quantities
Sheets (all)
=10 Families

You can use these items with the copy or move commands, or edit the system, regardless of
where the original tab selection — based on the system — was defined.

BONUS TIP — Select any object that belongs to a system, such as a pipe or duct. Right click,
and choose the Hide in View > By Filter option:
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Cancel -

Repeat [Hide by Filter] : B

' . Recent Commands »

-

Hide in View > Elements
Override Graphics in View » Category

! Create Similar By Filter...

Edit Famnily

Select Previous

Select All Instances »

Delete
Find Referring Views

Zoom In Region
Zoom Qut (2x)
Zoom To Fit

Previous Pan/Zoom

Mext Pan/Zoom

Browsers »

The VG Filter tab will appear, and allow you turn anything associated with a filter related to that
object on or off. Deselecting the visible option will turn ALL connected pipe in the system off,
based on the categories associated with the filter, and the assigned rule:

~  Properties

/

Visibility/Graphic Overrides for 3D View: 3D Plurbing *

Model Categories  Annotation Categories  Analytical Model Categories  Imported Categories  Filters  Revit Links

o Projection/Surface Cut
Mame Visibility - - Halftane
Lines Patterns Transparen... Lines Patterns
Override... Override... Owerride...

You can also override other graphics settings for projection/surface, cut and half tone from this
tool (or the Override Graphics in View option).

Using Systems with Groups

On some projects, systems can be repeated in several locations in a project. If you plan on
using a typical system as a copy for others, you should consider using the group tool first. But
there are a few rules you need to know before you get started.
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1. When selecting items for a group using the tab selection method, the system must not
contain open systems, or unconnected devices or circuits.

******************************************************

______________________________________________________

Autodesk Revit 2017
Error - cannot be ignored = 1 Error, 1 Warning

None of the selected elements can be grouped. The elements may already be
arouped or may be element types which are ot allowed for grouping.

<< 102 e Show More Info Expand >>

OK Cancel

Select items that are well-connected, such as a completed duct system layout that
includes targets and sources, or a fully circuited system that includes wiring.

| <d [

330 | Edit Ungroup Link
5" | Group

2. Once in a group, you can edit the group, and create systems/circuits for items which
belong in the group.

3. When using groups to copy to other locations in a project, when the items are
ungrouped, they are automatically assigned to a new system, provided the previous
items were well-connected.

4. Creating connections to items in a group is limited. Since the group is contained as one
entity, you would need to edit the group in order to add, remove or edit items within a
system. However, you can connect to other connectors on a family (such as a duct or
pipe connector) that is not already assigned to another system.

5. When copying systems from level to level, these systems work best when non-hosted
target and source families are used, and the items placed in a group. When the items
are ungrouped, they will automatically be associated with the corresponding level. When
a hosted item is added to the group, the association to the original host is lost, but the
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group can still be defined. You would have to re-associate the hosted families to their
new host (which is one of the reasons why we rarely use hosted MEP families!).

6. If you are planning to use the same layout in other projects, create a model group first.
Once the items are grouped, they can be saved as a Revit project file (.RVT). The group
can then be imported into another project. The rules apply — the group must be well-
connected! Use the Insert > Load as Group tool to bring the group into a new project.

The grouping tools are located on the Modify tab, when items are selected:

Modify | Multi-5elect | Duct Systems

1 : Designte | Justify | Filter =
Fabrication 2% Edit
sure Create Fabrication | Edit Selection

You can also create groups by selecting the tool from the Modify tab, Create panel, when items
are not selected:
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Modify
[ ] [t
i_I_I:’J | L]
S
s
Create Group =
Name: |
Group Type
(®) Model
() Detail
| ok || Cancel || Heb |

Once the tool is started, the Edit Group tool opens, allowing you to use window or pick
selections, but not tab selections for systems:

e B v X

Add |Remove Attach = Finish Cancel

Edit Group l
Lt

i

N/

STROOM

] &t

So it’s best to select the items by the well-formed system first, and then use the group tool
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BIG TIME NOTE: Groups can affect project performance if used in great numbers. Use the
groups instead to create duplicates, or move to different levels or areas of the project, and then
UNGROUP the items. This also makes sure the systems are correctly defined.

Tracking System Equipment Data with Spaces

Our last segment covers how data that is associated with system objects can be related to the
space associated with the room. In some cases, you may want to know what the airflow is for a
room, or the total lighting/receptacle load is for a space. Space objects in Revit can track this
data easily, so it's important to understand where you can review and control this data.

Duct System Data
When a duct is placed in a room where a Revit space object is located, the space will track the

flow assigned to the air terminal(s) as long as the air terminal falls within the vertical boundary of
the space. Here’s an example from a section view showing this correctly defined:

Fropertier =

.’)
Spaces (1)
| Constamnty 2 A
[ s timi A i T | ™
Limit Offset W : o=l S §
| Base Offset oo )(( - b )
Electrical - Lighting ¥ [ i \
|Electrical - Loads £
Dimensions ¥
P . ROOF L _ _ _ _

| Specified Supply Aidfiow 0.00CFM
| Heturn sueticw Spectied c —— i
| Spectied Retuen Airflow 0,00 CFM - b = d

| Specified Exhaust Airflow 0.00 CFM

certity Data %
HNumber 4
N MEETING ROCM

Erogperties help

Projed Drowier - 19650-MIP.AT *

Hexth - Elec
Seuth - Dlec

Note the properties of the space — even though the limit offset is set to be higher that the
terminals, the space is limited by the ceiling object. As long as the terminal is in contact with the
ceiling face on the side of the space, the space will track the airflow. But if the space upper limit
offset is not set high enough to intersect the air terminals, the airflow will not be included:
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HNumnber 4
HNeme

Project Brcwrice - 198581 MER vt
Marth - Elec
Srusth - Flar

Brapeertin *
Spaces (1)
Constraints 2 A
Upper Limit FIRST FLOOR
Lima Otfset IS
Bave Offset T
Electrical - Lighting %
Electrical - Loads ¥
Dienensans T ?C
Mechanical « Flow Ed
Speeied Supply Anflow a0 Cha
en Al Specdied
Return Airflow Q.00 CFM
Specdved Exhucct furllcrw a0 cha
Identity Dats %

MEETING ROOM

)OF

The calculated value will be populated after the duct sizing tool is used. You can then create a
space schedule that tracks the actual supply airflow per room.

Electrical Power/Lighting Data

Similar to the mechanical flow data, a space can track electrical loads, based on power, lighting
or other load types. For example, if a light is placed in a space and is defined as a light source,
the space will automatically calculated the average estimated illumination. This load can be
reported in a space schedule, and compared to the circuit load values.

To enable the light source in a fixture, edit the family. Open the Family Category and
Parameters — under Family Parameters, make sure Light Source is checked:

B Family Category and Parameters

Family Category

Filter list: | <show all= ~

Duct Accessories
Duct Fittings
Electrical Equipment
Electrical Fidures
Entourage

Fire: Mlamm Devices
Fumiture

Fumiture Systems
Generic Models
Lighting Devices
Lighting Fixtures
Mass

Family Parameters

Parameter Value
Cut with Voids When Lo |[]
Light Source
Part Type Normal
Round Connector Dime : Use Diameter
Shared O
cance

X
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When the light is added to the room, the photometric values are used in association with the
light fixture type are used to calculate the average estimated illumination.

Type Properties X
Famiy: | Troffer Light - 2x4 Parabolic v | load.. |
Type: | 2x4(2 Lamp) - 120V v Duplicate... |

Type Parameters

Parameter | Value ~

Default Elevation

Load Classification Lighting - Dwelling Unit
Lamp T-12

Ballast Voltage 120,00V

Ballast Number of Poles 1

Wattage Comments

Apparent Load :80.00 VA

Tilt Angle -90.00°

Photometric Web File 24421 2.ies

Light Loss Factor 0.28

ntial Inensity U RRWe B MW
Initial Color [ 430K
Emit from Rectangle Width 20"

Emit fromn Rectangle Length 40"

Emit Shape Visible in Rendering 1

Dirnring Larnp Color Termperature i <Mone=

Color Filter White

Light Source Definition (family) Rectangle+Photometric Web

<< Preview | | oK || Cancel || Apply

In this case, the Initial Intensity overrides the apparent load value, which is used to define the
circuit load. It's important to understand how these two items differ, and how both are used to
define information about your circuits and systems,
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Conclusions

Understanding how to leverage systems within your project can significantly improve the quality
of your design. Learning how to account for these tasks to improve the project quality isn’'t as
complicated as it seems, as long as you understand the ground rules and benefits.
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